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No table of figures entries found. 
In your document, select the words to include in the table of contents, 
and then on the Home tab, under Styles, click a heading style. Repeat 
for each heading that you want to include, and then insert the table of 
contents in your document. To manually create a table of contents, on 
the Document Elements tab, under Table of Contents, point to a style 
and then click the down arrow button. Click one of the styles under 
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(Beginnings of) Document Element Index 
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Essential information 

Installation 
Word templates 

The isolated, uncapitalized word “template” in this 
document always means a Microsoft Word template, 
never a UPnP Service or Device Template 

 When referring to a UPnP Service or Device Template, 
the word “Template” is always capitalized. 

Two Word templates are required for UPnP documents 
• upnp4iec.dot holds all styles 
• upnp4iecAdjunct.dotm contains the UPnP 

ribbon and all programmatic support 
 IMPORTANT  Both templates must be read-only 
Where to install templates: 

• upnp4iec.dot 
– “User templates” folder OR 
– “Workgroup templates” folder 

• upnp4iecAdjunct.dotm 
– Word “Startup” folder 

 

Word templates (cont.) 
How to locate template folders  

• Navigate to the Options Advanced tab: 
– in Word 2007, select the Office Button > 

Word Options > Advanced tab 
– in Word 2010, select the File tab > Options > 

Advanced tab 
• On the Advanced tab, scroll down to the General 

section and click the File Locations… button (tip: 
click the Modify button to see full path names) 

 

 

System Requirements 
Operating System 

Windows XP thru Windows 7 
• Untested on Windows 8 
• Will not work on OS X 

 

Microsoft Word 
Word 2007, Word 2010 

• Untested on Word 2013 
• Untested on Office 365 
• Will not work on Word 2003 or earlier 
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Style Usage 
Formatting with approved styles 

 IMPORTANT  To prepare UPnP documents for ISO/IEC 
publication, formatting is restricted to approved, named 
paragraph and character styles from either of: 
• the “standard” IEC style set 
• the UPnP extended style set 

Direct formatting is not allowed 

Applying approved styles 
All approved styles are available from the UPnP ribbon tab 

(see “Contents of UPnP Ribbon Tab”, p. 8; “Approved 
character styles”, p. 24; “Approved paragraph styles”,  
p. 25) 

Usage guidance for ribbon operations is given in tooltips—
shown by hovering over the ribbon entries 

Enforcement of approved styles 
For UPnP editors, style restrictions are enforced with 

Word’s “Restrict Formatting and Editing” control  
 IMPORTANT  These restrictions disable: 

• applying unapproved styles 
• direct formatting 
• Some common Word operations that use direct 

formatting: 
Home tab > Font > any  
Home tab > Paragraph > any  
Page Layout tab > Paragraph > any 

If absolutely necessary, restrictions can be disabled 
temporarily (UPnP tab > Miscellaneous > 
UnRestrict), but they will be re-enabled with the next 
operation initiated from the UPnP ribbon tab 

IEC style set 
ISO and IEC share a common set of style requirements for 

all of their published standards [1] 
To support these requirements, IEC has defined a fixed set 

of named Word styles, which are used for most UPnP 
document content: 
• Headings 
• Lists 
• Basic table cells 
• Figure and table titles (captions) and footnotes 
• Terms and definitions 
• Notes and Examples 

UPnP extended style set 
The IEC style set is not sufficient to convey all UPnP 

content meaning, so UPnP has created an extended set of 
named styles for  
• UPnP defined names (arch, forum, …) 
• Code — both XML and HTTP 
• Enhanced table cells 
• Hierarchical documentation for XML & HTTP 
• Many other uses (see “Approved character styles”, 

p. 24, and “Approved paragraph styles”, p. 25) 
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Terminology and structural changes for ISO/IEC, YES 
Structural terms 

Clause—first level numbered subdivision of main body (1, 
2, …) or annex (A.n, B.n, …) 

Subclause—numbered subdivision of a clause or subclause 
Annex—supplemental material following the main body; 

may be either normative or informative 
Do not use the terms chapter, section, subsection or 

appendix 

Provisioning terms 
Provisioning terms are those that define conformance, and 

permissibility, or declare possibility and capability. See 
“Verbal forms for the expression of provisions”, p. 22, 
for important detail. 

There are no upper/lower case distinctions in ISO/IEC. 
Provisioning terms have only one meaning, regardless of 
capitalization or context. 

Most frequently used provisioning terms: 
 ISO/IEC Former equivalent (RFC 2119) 
 shall MUST 
 required REQUIRED 
 should SHOULD  
 recommended RECOMMENDED 
 may MAY 
 permitted, allowed OPTIONAL 
 can, could, might (non-normative) may 
 must (see p. 22) no prior equivalent 

 

Standard document elements 
Clauses 1 (Scope), 2 (Normative references), and 3 (Terms, 

definitions, …) are ISO/IEC required and have specific 
content requirements 

Clauses 2 and 3 have ISO/IEC formatting requirements 
Clause 4 (Notations and Conventions) is a new standard 

UPnP clause, with content from pre-ISO/IEC clause 1 
(Overview and Scope) 

Content of all numbered clauses is always normative. 
Therefore, “Theory of operation”, which has always 
been informative, is now an annex 

For more detail, see 
“Document structure and content”, p. 12 
“Service specification detail”, p. 16 
“Error! Reference source not found.”, p. 19 (not 
available yet) 
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Contents of UPnP Ribbon Tab 

All menu entries and buttons, and most menus, on the UPnP Ribbon 
tab have tooltips, which will display by hovering over the item.
Info 

Style ▼ Display and change character or paragraph style of 
selection when the style is homogeneous 

Font ▼ Disabled when restrictions are active 
Font size▼ Disabled when restrictions are active 

Paragraph Styles 
Headings▼ Styles for main body or annex headings 
Hdgs (rare)▼ Styles for rarely used heading types 
Title page▼ Styles for UPnP title and subtitle 
Terms ▼ Styles that are unique to clause 3, “Terms, …” 
Code ▼ Styles for XML and HTTP code 
The rest ▼ The remainder of the approved paragraph styles 

that are not specific to lists, figures or tables. 

List Styles 
a) ▼ Styles “List Number n” 
• ▼ Styles “List Bullet n” 
– ▼ Styles “List Dash n” 
List ▼ Styles “List n” 
   … ▼ Styles “List Continue n” 
Doc’n ▼ Styles for documentation:  

“Doc Xcode n”  
“Doc Text n”  
“Doc Bullet n”  
“Doc Ncode n” 

Level Adjust Each level adjust operation applies to the subset of 
paragraphs in the current selection with styles 
appropriate to the operation. Other paragraphs 
are ignored, without notification. 

  Hdg    Promote (  demote) heading level to the next 
higher (lower) level in the hierarchy, when that 
level exists. 

  List    Promote, or unindent, (  demote, or indent) list 
level to the next higher (lower) level in the 
hierarchy, when that level exists. 

  Code    Remove (  add) one tab character to reduce 
(increase) the indentation level of each selected 
code line. 

Character Styles 
B    I     U Toggle the bold, italic or underline character 

property of the selected text using UPnP-
extended-set character styles. 

for    a    v Apply forum, arch, or vendor style, respectively 
Code ▼ Styles for inline XML and HTTP code 
The rest ▼ Remaining approved character styles 
CLEAR  Clears all added character styling, leaving the 

selection styled according to its paragraph style 

Tables & Figures 
Table ▼ Operations for table captions, footnotes and notes, 

and table-specific styles 
Figure ▼ Operations for figure captions and figure-specific 

styles 
Captions▼ Operations to add captions or verify formatting of 

all captions  
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Miscellaneous 
Update ▼ Update and verify all Word fields, including 

hyperlinked cross-references 
Verify ▼ Operations to verify conformance of all cross-

reference and references 
Insert ▼ Operations to: 

Insert a reference (Normative or Bibliography) 
Insert a new annex 
Insert a new table of contents 
Perform safe paragraph insertions that 
     prevent corruption of bookmarks used 
     for cross-references. These are safe 
     for both user-defined and hidden Word 
     bookmarks. 

UnRestrict *** USE  WITH   EXTREME  CAUTION *** 
  Temporarily disables formatting and editing 

restrictions. 
  Restrictions will be re-enabled when the next 

ribbon operation is invoked. 

Conversion 
Old LowerCase… 
  Pre-ISO/IEC documents used ALL CAPS to 

signify normative terms. 
  This operation walks the user through all lower 

case terms that had, or appeared to have, an 
ordinary English language meaning before 
conversion, but that now have a normative or 
other provisioning meaning according to 
ISO/IEC definitions. 
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 “How to …” 

Initialize Service/Device Type and Version 
ServiceType and ServiceVersion are bookmarked for 

consistent name referencing throughout each spec 
To preserve the bookmark, go to Clause 1, first sentence, 

and replace the text "ServiceType" with the service type 
name, without deleting the leading and trailing 
underscores. Then, after the name is in place, delete the 
underscores. 

Repeat the same steps to enter the ServiceVersion number. 

Add a figure or table caption 
Place the cursor in a table, or select a figure. 
Select UPnP tab > Tables & Figures > Captions > Add 

Add a reference 
To add a reference in either of the “Normative references” 

clause or the “Bibliography” annex: 
• Place the cursor on the line before where you want the 

new reference to be added 
• Invoke the UPnP ribbon operation 

UPnP tab > Miscellaneous > Insert > Reference… 
• You will be prompted for a bookmark name. 
 The preferred convention is to begin each bookmark 

name with “ref_”, which groups all reference entries 
together for cross-referencing 

• For reference content details, see “Reference entries, 
ISO 690 conformance”, p. 21 

 IMPORTANT  Use of this ribbon operation prevents the 
most common problem of manual entry—corruption of 
the bookmarks used for cross-referencing 

 

Format state variable & action subclause titles 
Each level 3 subclause title comprises the variable/action 

name, followed by it provisioning status in parentheses. 
 To format the title, do the following 

• Apply forum style to the variable or action name 
(UPnP tab > Character Styles > for)  

• Apply charBold style to the provisioning text 
(UPnP tab > Character Styles > B). 

 The net effect of applying the bold style to provisioning 
text is to negate the heading’s default bold style. 

Document XML structures 
Use (only) the styles “Doc … 1” thru “Doc … 7” 
For the name of each XML element, use style “Doc Xcode 

n”, where n is the element’s level in the XML document. 
Typing return at the end of the line automatically sets the 

following ¶ style to “Doc Text n” for the description 
Document each property or attribute of an element at level 

n+1, prefixing the property/attribute name with the @ 
sign. 

When an element has both attributes and subelements, 
document all attributes before any of the subelements. 

Single-level bulleted lists are also enabled at each element 
level using style “Doc Bullet n”, with “Doc Text n”. 

Finally, for hierarchical elements of HTTP or other 
“network” code, use the styles “Doc Ncode n”, with the 
corresponding description styles, “Doc Text n” and 
“Doc Bullet n”.  
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Avoid corruption of bookmarks and cross-references 
Every heading paragraph, caption paragraph and external 

reference paragraph has a bookmark at its start that can 
be corrupted when entering new text before it. 

Many of these also have bookmarks that end at the end of 
the paragraph. These bookmarks can be corrupted when 
entering new text at the end of the paragraph 

Any list paragraph or other paragraph that is the target of a 
cross-reference also has such a corruptible bookmark 

Two new entries in the UPnP ribbon can prevent these 
corruptions. To use either, place the cursor in the 
paragraph before or after which you want to add the new 
text, then select the appropriate ribbon operation: 

UPnP tab > Miscellaneous > Insert > …before 
UPnP tab > Miscellaneous > Insert > …after 
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Document structure and content 

Introductory document elements 
 

Table 1 — Introductory document elements 

Element type  Elt. # Title  Content 
(publisher differences in bold) 

Informative  
Required (U, I) 

– Title page (Title is 
document specific) 

UPnP: “Traditional” UPnP content, using ISO/IEC and UPnP-specific styles. 
UPnP title page is not used by ISO/IEC. 

ISO/IEC: Written by ISO/IEC. No reused UPnP content. 
Informative  

Required (U, I) 
– Table of contents Identical: Per ISO/IEC requirements, includes levels 1-3 in the normative body, and only level 1 for 

annexes. 

Informative  
Required (I) 
Excluded (U) 

– Foreword ISO/IEC: Only in ISO/IEC, written by ISO/IEC. 

Informative  
Allowed (U, I) 

– Introduction UPnP: When needed, content should be what will be submitted to ISO/IEC. 
Rare in UPnP documents. 

ISO/IEC: Explains why this document is needed, either because the subject matter is not covered by 
other international specifications, or because of limitations or omissions in those specifications. 

Normative 
Required (I) 
Excluded (U) 

– Title ISO/IEC: Only in ISO/IEC, written by ISO/IEC. 

Normative  
Required (U, I) 

1 Scope This clause is normative, but shall not contain requirements. 
It shall be succinct, so that it can be used as a summary for bibliographic purposes. 
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Table 1 — Introductory document elements 

Element type  Elt. # Title  Content 
(publisher differences in bold) 

Normative  
Required (U, I) 

2 Normative references  IMPORTANT  Do not change the wording of the introductory paragraph in the Template. The existing 
wording is required by ISO/IEC. 

Common: Always include the version(s) of the UDA that this spec conforms to. 

For services with XML schemas, include one reference for each schema. Be sure schemas are 
named according to [6]. 

Contains only normative, not informative, references. Informative references shall be entered in the 
Bibliography annex. 
Every entry shall be referenced in the document. If it's not referenced in the document, it belongs in 
the Bibliography. 

UPnP: Most, not necessarily all, references to UPnP documents will be to the UPnP-published version. 

ISO/IEC: All references to UPnP documents should be to the ISO/IEC-published version. 



 Document structure and content  

UPnP Editing Guide  – 14 – May 31, 2014 

Core document elements 
 

Table 2 — Core document elements 

Element type  Elt. # Title Content 
(no publisher differences) 

Normative  
Required (U, I) 

3 Terms, definitions, sym-
bols and abbreviated 
terms 

IMPORTANT  Do not change the wording of the introductory paragraph in the Template, except for 
including definition sources in addition the UPnP Device Architecture. The existing wording is 
required by ISO/IEC. 

Directly contains, and/or references other document(s) that contain, all terms, symbols and abbreviated 
terms used in the current document that are necessary for its understanding (see also TBS) 

IMPORTANT  Retain the abbreviated terms “A”, “R” and “X”, instead of repeating them in table 
footnotes. Remove the conditional terms and abbreviations only if not used in the current document. 

Normative  
Required (U, I) 

4 Notations and 
conventions 

Explain here any notations, such as a shorthand mechanism for describing comma-separated-value list, 
or conventions, such as the use of italics to denote names with special meaning. 

When the same notations and conventions are used for multiple related specifications, put them in 
one spec only and reference it in the others. Candidates for the sole-source spec include, a device 
spec, a central service spec or an architecture spec. 

Model for referencing the source spec (where [n] is the reference for the source document): 
 

4 Notations and conventions 
See [n], clause 4, for notations and conventions used in this document  

5 … 

IMPORTANT  Working Committees are strongly urged to use this single-source referencing method. 
Normative  

Required (U, I) 
5 Service/Device model See Table 4 for Service model details, Table 5 for Device model details 

Normative  
Required (U, I) 

6 XML service/device 
description 

Contains the service scpd XML document or the device root XML document. 

Normative  
Required (U, I) 

7 Test Contains description of all tests defined for this service or device. 
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Supplementary document elements 
 

Table 3 — Supplementary document elements 

Element type  Elt. # Title Content 
(publisher differences in bold) 

Informative  
Required (U, I) 

A Theory of operation Same content as when it was a main body subclause. 

In document sets, such as AV, with long-established conventions for annex ordering, “Theory of 
operation” need not be Annex A. However, for new document sets, or new documents that do not 
need to conform to such a pattern, “Theory of operation” should always be Annex A, for consistency 
across UPnP. 

Normative or 
Informative 

Allowed (U, I) 

B, C, 
… 

Additional annexes Zero or more annexes, as needed 

Mixture of informative and normative 

ISO/IEC expect annexes to appear in order according to their first reference in the document. 
However, for multi-document groups, such as AV, that use annexes consistently among multiple 
specs, ordering consistency within the group is more important than ordering by reference. 

Informative  
Allowed (U, I) 

 Bibliography IMPORTANT  Do not change the wording of the introductory paragraph in the Template. The existing 
wording is required by ISO/IEC. 

UPnP: Most, not necessarily all, references to UPnP documents will be to the UPnP-published version. 

ISO/IEC: Most, not necessarily all, references to UPnP documents should be to the ISO/IEC-published 
version. 
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Service specification detail 

Service model clause 
 

Table 4 — Service model subclauses 

Elt. # Title   Content 

5  Service model Parent clause for the normative definition of the service 
n.1  Service type IMPORTANT  Working Committee editors should not modify this subclause. It is automatically “filled” when the service type 

and service version are properly entered in their bookmarked locations in Clause 1, “Scope”. 

Declares the service’s unique identifying URN. 

Gives the unversioned name by which this service version is referred to in the current document. 
n.2  Service architecture Normative description of the service architecture and its basic functionality. 

Informative descriptions of operation and usage belong in the “Theory of operation” annex. 
n.3  State variables n.3.1  Summary 

• High-level introduction to the state variables and service state(s) that they represent 
• “State variables” table. 

All virtual state variables (named A_ARG_TYPE_...) are listed after all non-virtual state variables 

n.3.2…  VariableName (required | allowed | conditionally required | conditionally allowed ) 

One subclause per state variable, in the same order as in the “State variables” table. 
The subclause title is the state variable name (in forum character style), followed by its provisioning status in 
parentheses. 

The subclause contains a description of the state variable—its syntax and semantics. For conditional variables, 
describe the condition. Do not include the behavior of related actions—describe that in the appropriate action 
definitions. 
In addition to syntax and semantics, there are specific clause content requirements that depend on the state variable 
and its allowed value set. See “State variable subclauses”, p. 18, for details.  

n.3.last Relationships among state variables 
Optional subclause describing any inter-dependencies of state variables that were not included in individual state 
variable descriptions. 
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Table 4 — Service model subclauses 

Elt. # Title   Content 

n.4  Eventing and moderation n.4.1  Summary 
Contains “Eventing and moderation” table, which shall include every non-virtual state variable (excludes those named 
A_ARG_TYPE_…). 

In the “Criteria” column, for each evented variable: 
• Enter simple moderation criteria directly in the table 

• For complex criteria, add a level 3 subclause for the state variable to describe the moderation criteria. Enter a 
cross-reference to that subclause in the “Criteria” column. 

n.4.2… Eventing of VariableName 
Add a subclause for each evented variable that needs more description than is in the eventing table. 

When no variables need more description (there is no subclause n.4.2) delete the n.4.1 heading before the eventing table. 

n.5  Actions n.5.1  Summary  
Contains “Actions” table 

n.5.2…  ActionName (required | allowed | conditionally required | …) 

One subclause per action, in the same order as in the “Actions” table. 

Subclause title is action name, followed by its provisioning status. See TBS for content detail.  
n.5.x  Relationships among actions 

Describe all functional relationships among actions that were not described in individual action subclauses, or that are 
more appropriately included here. 

Briefly mention relationships that were described in individual action subclauses. 

If every action is completely independent of every other, enter: “None.” 
n.5.x+1  Error code summary 

Contains “Error code summary” table 
n.6  Service behavioral 

model 
There is currently no guidance from the TC on the content of this subclause, other than it has two suggested subclauses. 

Their individual content is suggested by their titles. 

If there are no state diagrams, remove the second subclause, and remove the “General” subclause heading paragraph. 
n.6.1  General 
n.6.2  State diagrams 
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State variable subclauses 
Summary 

Brief (1-2 lines) description of state variable, including the 
condition for conditional variables 

For virtual state variables 
If the set of actions using this variable as an argument 

data type is small, list the actions here, 
Otherwise, enter “for various actions and arguments”, 

and defer the details to the “Description” subclause 

Description 
Detailed description of the state variable. If necessary, 

elaborate on the condition for conditional variables. 
DO NOT include behavior of related actions. Put that in the 

action’s definition. 
DO NOT include eventing behavior. Put that in the 

“Eventing and Moderation” subclause. 
For virtual state variables list the actions that use this 

variable if not given in the “Summary” subclause 
For documenting, there are four kinds of state variables: 

• “Unconstrained” of any type 
• Range-valued of any numeric type 
• Discrete-valued of type string 
• XML-valued of type string 

According to kind, include the following in the 
“Description”: 

“Unconstrained” 
Include the variable’s default value. If the service 

specification does not define a default value, indicate 
whether it is undefined or vendor-defined. 

Range-valued 
Include an allowed value table of the following form: 

Table x — allowedValueRange for varName 

Subelement Value R/A  

minimum 3 R 

maximum Vendor-defined R 

step 2  A 

default 9 R 

Discrete-valued 
Include an allowed value table of the following form: 

Table y — allowedValueList for varName 

Value R/A  

“Value1” R 

“Value2” (DEFAULT) R 

“Value3” A 

Vendor-defined X 

XML-valued  
Include: 

• The general description 
• Either the XML schema for the variable or a 

reference to the schema document 
• A description of all elements and attributes, in 

hierarchical form. See “Document XML structures”, 
p. 10 
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Individual action subclauses 
Action subclause title (level 3) 

Formatted as:  
ActionName() (provisioningStatus) 

For how to format, see “Format state variable & action 
subclause titles”, p. 10 

Description (level 4) 
Describe the action’s behavior completely 
When the action is conditionally required or conditionally 

allowed, also describe the condition 

Arguments (level 4) 
Contains the arguments table 

Argument descriptions (level 4) 
Include one level 5 subclause for each argument 
Each subclause title consists solely of the argument name, 

formatted as: ArgName 
Each subclause describes its argument’s meaning to, and 

use by, both the action and the action’s caller 

Service  requirements for ActionName() 
If there are requirements on the service, enter them here. 
Otherwise, enter: “None.” 

Control point requirements for calling ActionName() 
If there are requirements on the control point when calling 

this action, enter them here.  
Otherwise, enter: “None.” 

Dependence on service state 
If the behavior or result of this action depends on the 

service state in any way, explain it here. 
Be sure to describe: 

• dependence on state variables  
• dependence on prior invocations of this or other 

actions 
• dependence on service internal state that might not 

otherwise be visible 
Otherwise, enter: 

 “None.”  

Effect on service state 
If invoking this action changes the service state in any way, 

describe it here. 
Be sure to describe: 

• all immediately affected state variables 
• any state change that could affect a state variable later 
• any state change that could affect the operation of 

another action 
Otherwise, enter: 

 “None.” 

Errors 
Contains the table of error codes for the individual action 
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Device specification detail 

Device model clause 
 

Table 5 — Device model subclauses 

Elt. # Title   Content 

5  Device model Parent clause for the normative definition of the device 
n.1  Device type IMPORTANT  Working Committee editors should not modify this subclause. It is automatically “filled” when the device type 

and service version are properly entered in their bookmarked locations in Clause 1, “Scope”. 

Declares the device’s unique identifying URN. 

Gives the unversioned name by which this device version is referred to in the current document. 
n.2  Device architecture Normative description of the device architecture and its basic functionality. 

Informative descriptions of operation and usage belong in the “Theory of operation” annex. 
n.3  Embedded services and 

devices 
Contains a very brief description of the embedding requirements and the table that lists and shows the structure of the 

embeddings 
n.4  Embedded services Contains one subclause for each embedded service, and a final subclause that describes the relationsips among the 

embedded services 
n.5  Embedded devices Contains one subclause for each embedded device, and a final subclause that describes the relationsips among the 

embedded devices 
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Conformance requirements — detail 

Reference entries, ISO 690 conformance 
UPnP now uses numbered designators—one of the formats 

allowed by ISO 690—to identify reference entries. 
This is a change from the prior convention of textual 
designators. 

A dated reference indicates that this document complies 
only with the specific version of the reference indicated 
by the date. 
• The "Available from:" URI for a dated reference shall 

refer to the specific dated version. 
• DO NOT add a "Latest: <URI>" to a dated reference 

unless it is always guaranteed to reference a 
document with only editorial, not technical, changes 
from the original reference. 

• For dated references use one of the following date 
forms: 
 2008 
 October 2008 
 15 October 2008 

An undated reference indicates that this document 
complies with the latest version of the reference, 
regardless of changes to the reference since this 
document was published. 
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Verbal forms for the expression of provisions  (complete contents of [1], Annex H) 
 

Annex H 
(normative) 

 
Verbal forms for the expression of provisions 

NOTE Only singular forms are shown. 

The verbal forms shown in Table H.1 shall be used to indicate requirements 
strictly to be followed in order to conform to the document and from which no 
deviation is permitted. 

Table H.1 — Requirement 
Verbal form Equivalent expressions for use in exceptional cases 

(see 6.6.1.3) 

shall is to 
is required to 
it is required that 
has to 
only is permitted 
it is necessary 

shall not is not allowed [permitted] [acceptable] [permissible] 
is required to be not 
is required that be not 
is not to be 

Do  not  use  “must”  as  an  alternative  for  “shall”.  (This  will  avoid  any  confusion 
between the requirements of a document and external statutory obligations.) 

Do not use “may not” instead of “shall not” to express a prohibition. 

To express a direct instruction, for example referring to steps to be taken in a test method, 
use the imperative mood in English. 

EXAMPLE “Switch on the recorder.” 

The verbal forms shown in Table H.2 shall be used to indicate that among several 
possibilities one is recommended as particularly suitable, without mentioning or 
excluding others, or that a certain course of action is preferred but not necessarily 
required, or that (in the negative form) a certain possibility or course of action is 
deprecated but not prohibited. 

Table H.2 — Recommendation 
Verbal form Equivalent expressions for use in exceptional cases 

(see 6.6.1.3) 

should it is recommended that 
ought to 

should not it is not recommended that 
ought not to 

In French, do not use “devrait” in this context. 

The verbal forms shown in Table H.3 shall be used to indicate a course of 
action permissible within the limits of the document. 

Table H.3 — Permission 
Verbal form Equivalent expressions for use in exceptional cases 

(see 6.6.1.3) 

may is permitted 
is allowed 
is permissible 

need not it is not required that 
no is required 

Do not use “possible” or “impossible” in this context. Do not use “can” instead of “may” in 
this context. 

NOTE 1      “May” signifies permission expressed by the document, whereas “can” 
refers to the ability of a user of the document or to a possibility open to him/her. 

NOTE 2      The French verb “pouvoir” can indicate both permission and possibility. For 
clarity, the use of other expressions is advisable if otherwise there is a risk of 
misunderstanding. 
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The verbal forms shown in Table H.4 shall be used for statements of 
possibility and capability, whether material, physical or causal. 

Table H.4 — Possibility and capability 
Verbal form Equivalent expressions for use in exceptional cases 

(see 6.6.1.3) 

can be able to 
there is a possibility of 
it is possible to 

cannot be unable to 
there is no possibility of 
it is not possible to 

NOTE See Notes 1 and 2 to Table H.3 
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Approved character styles

Table 6 — Approved character styles

Character style a Used for: 
arch UDA-defined names and symbols 

charBold Named styles for character formatting 
 
Always use 
B  ,   I  , U   on the ribbon UPnP tab 
 
Do not use direct formatting 

( B  ,   I  , and  U   on the ribbon Home tab, 
or Ctl-B, Ctl-I, Ctl-U from the keyboard)  

charBoldItalic 

charBoldItalicUnderline 

charBoldUnderline 

charItalic 

charItalicUnderline 

charUnderline 

charNcode “networking”-related names and symbols 
embedded in differently formatted text 

charXcode code names and symbols embedded in 
differently formatted text 

Descriptor Working Committee-defined identifiers other 
than names of state variables, actions, 
arguments and properties—items such as EPG 
feature (from AV) and Phone Data Model (from 
Telephony) 

Character style a Used for: 
Footnote Reference superscripts that reference footnotes 

forum Working Committee-defined names and 
symbols 

gena GENA (General Event Notification Architecture)-
defined names and symbols 

Page Number only for page numbers in Header or Footer 

SMALL CAPS small caps 

soap SOAP-defined identifiers 

ssdp SSDP-defined identifiers 

textSUBscript subscripts 

textSUPerscript superscripts 

VARIABLE variable names in equations and formulae 

vendor vendor-defined names and symbols 
a Gray shaded cells contain IEC-defined styles. Unshaded cells contain UPnP-defined styles. 
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Approved paragraph styles 

Table 7 — Approved paragraph styles

Paragraph style a Used for: 
AMD-heading1 
AMD-heading2 

amendment headings 

ANNEX_title annex title 

ANNEX-heading1 / 2 / 3 / 
 4 / 5 

annex clause and subclause headings 

Doc Bullet 1 / 2 / 3 / 4 / 
 5 / 6 / 7 

documenting hierarchically structured code 

Doc Ncode  1 / 2 / 3 / 4 / 
 5 / 6 / 7 

Doc Text  1 / 2 / 3 / 4 / 
 5 / 6 / 7 

Doc Xcode  1 / 2 / 3 / 4 / 
 5 / 6 / 7 

EBNF EBNF syntax productions 

FIGURE all figures—to center them  

FIGURE-title self-explanatory 

Footer document page footer 

Footnote text standard Word footnotes 
Not used for figure & table footnotes—see 
“TAB_FIG_footnote” below. 

FOREWORD Not used by UPnP 

Formula equations and formulas 
Left-justified; indented, with hanging indent, like 
“List 2”; but has a right-tab at the right margin 
for the equation or formula number 

Header document page header 

Heading 1 / 2 / 3 / 4 / 5 / 6 numbered clauses & subclauses of main body 

Paragraph style a Used for: 
HEADING(Nonumber) unnumbered introductory clauses, such as 

Foreword, Introduction, (Table of) CONTENTS 

List, List 2 / 3 / 4 / 5 unordered, unmarked lists with hanging indent 

List Bullet 
List Bullet 2 / 3 / 4 / 5 

unordered, bulleted lists—same bullet all levels 

List Continue 
List Continue 2 / 3 / 4 / 5 

continuation paragraphs for any other list type 

List Dash 
List Dash 2 / 3 / 4 

unordered, dashed lists—same dash all levels  
NOTE: Stops at level 4, unlike other “List ...” styles. 

List Number 
List Number 2 / 3 / 4 / 5 

numbered lists, sequence values: 
a) lower case English alphabet  
 1) Arabic numerals 
  i) lower case Roman numerals 
   a) lower case English alphabet 
    1) Arabic numerals sequence. 
Sequence restart rules: 
Level  1 sequencing only restarts after “Heading 
…” or “ANNEX…” styles. Prevents ambiguous 
references—there can be only one paragraph 
numbered 3.4 a), no matter how many disjoint 
numbered lists there might be in subclause 3.4. 

MAIN-TITLE Not used by UPnP 

ncode “network” code, such as HTTP headers 
Uses the proportionally spaced font “Arial”. If a 
monospaced font is needed for clarity, use the 
style “xocde” below.  

NOTE all notes 
should also be used for EXAMPLES 
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Paragraph style a Used for: 
Numbered PARA (level 2) 
Numbered PARA (level 3) 

numbered headings that are kept out of the 
Table of Contents 
These styles produce numbering identical to 
that of Heading 2 and Heading 3. If they are 
interspersed with Heading 2 and Heading 3 
elements, the Heading elements will still appear 
in the Table of Contents, but with gaps in their 
numbering sequences. 

PARAGRAPH normal document body text—justified 
Used where “Normal” or “Body text” might be 
used in other documents. 
Never use styles “Normal” or “Body text” 

PARAGRAPH_Left external reference entries—left justified variant 
of PARAGRAPH 

PropertyTypeLine property descriptions in AV documents 
supports lines of the form: 
NS: srs PDT: xsd:string MV: NO 
where: 
 NS   = Namespace 
 PDT = Property Data Type 
 MV   = Multi-Valued 

TAB_FIG_footnote table and figure footnote text 

Table of Figures auto-generated tables of Tables and Figures 

TABLE-cell default for all table cells except column 
headings—left justified 

TABLE-cell-bullet single level bulleted list in tables 

TABLE-cell-list single level unlabeled list in tables 

TABLE-centered centered variant of “TABLE-cell” 

TABLE-col-heading table header cells—centers and bolds text 

Paragraph style a Used for: 
TABLE-row-heading column 1 table cells when they act as header 

labels for rows—centers and bolds text 

TABLE-title Self-explanatory. 

TERM term name(s) in Clause 3 

TERM-definition term definition in Clause 3 

TERM-number first-level term elements in Clause 3 
Numbers like “Heading 2”, but produces no 
entry in table of contents. 

TERM-number 3 second-level term elements in Clause 3 
Numbers like “Heading 3”, but produces no 
entry in table of contents. 

Title title on ISO/IEC cover page 
Not used by UPnP 

Toc 1 / 2 / 3 / 4 / 5 / 6 auto-generated table of contents 
xcode XML code, or any other monospaced code-like 

text 
Replaces old “code” and “SCPD” styles, which 
no longer exist. 
Indentation levels are controlled manually with 
tabs. Do not attempt to adjust left margin, 
hanging indent or first line indent to control 
indentation of code. 

xcodeGray gray background variant of “xcode” to highlight 
code segments 

xcode compact compact variant of “xcode” with smaller text and 
tighter tab spacing to allow more text on 
indented lines. 

xcodeGray compact gray variant of “xcode compact” 

a Gray shaded cells contain IEC-defined styles. Unshaded cells contain UPnP-defined styles. 
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Known problems and issues 

upnp4iec.dot or upnp4iecAdjunct.dotm has 
been modified … 

Some users, on saving documents or quitting Word have 
had the following alert pop up: 
 

 
Always click “Cancel” if this occurs with either of these 

templates. 
upnp4iec.dot and upnp4iecAdjunct.dotm 

should always be marked Read-only on your system. 
These Word templates should never be changed except 
by a knowledgeable developer in a controlled 
environment. 
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Background 
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Eventual ISO/IEC publication 
As an ISO/IEC approved standards creation body, all UPnP Forum 
specifications are expected to be published by ISO/IEC. Each specification is 
first published by UPnP, then submitted to IEC editors for ISO/IEC 
publication. 

ISO/IEC conformance 
There will always be a small set of differences between the content of UPnP- 
and ISO/IEC-published documents. But, with two minor exceptions explained 
later (see Error! Reference source not found.), there are no essential 
differences between UPnP and ISO/IEC requirements in the entire body of 
numbered clauses and annexes. Therefore, except for essential differences, 
all UPnP documents should follow ISO/IEC requirements, so as to minimize 
the changes needed for ISO/IEC publication. These requirements include 
terminology, structure, layout, styles and some items of content. 

The primary reference for ISO/IEC structural and appearance conformance 
iError! Reference source not found.s [1], but the requirements for achieving 
that conformance in MS Word are defined by the IEC in [3] and in related 
online content accessible from [5]. 

 


